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LabVIEW Installation

You need the following Software

* LabVIEW (LabVIEW Professional Development System 32-Bit: English)

* NI-DAQmx (Hardware Driver for NI USB-6008, NI TC-01,
etc.)

* LabVIEW Control Desigh and Simulation Module
* LabVIEW MathScript RT Module

Note! These packages are separate downloads!

All LabVIEW Software can be downloaded here: www.ni.com/download



http://www.ni.com/download

Configuration

i

National Instruments is
the vendor of LabVIEW

High-Level Design Tools

Textual Math

1c=0.285+ 0.013;;

2[X Y] = meshgrid(x, y);
, 3z=X+i*Y;

| 4for k=1:30

5 z=z"2+c;

"", Gend

Simulation

Statechart

Control Monitor

Filling Acquire

Draining

\

National Instruments creates
both Hardware and Software

Graphical Programming

Macintosh

Windows

Desktop Platform

000

Embedded Platform

f Real-Time FPGA MPU \




LabVIEW = Fun!

Graphical Programming:

* Very different from traditional programming like VB, C#, Maple,
MATLAB, MathScript, etc.

 [tis more like a “drawing program” than a Programming Language

* This makes it easy to use for those who are not programmers (or
dont like programming ©)

* Excellent tool when using Hardware, when you need to take
Measurements (DAQ), etc.

 [tis fun and makes you very creative!



LabVIEW Example

LabVIEW has the same things as other programming languages, but in a graphical way!

Sequence Structure  Comment 1. Loop Sub VI Local Variable
File Edit View [ Project Operate Tools Window Help
Ic{)]@]&l@[w]lﬁ’ < |15ptAppIicationF nt |~ ”ED'”:E';'”%I / |-| Search Q I@ -
Stacked Sequence Structure]

OO0 0000000000000 000

your own Pl controller

Chart Initialization

Note! Replace this contreller with

Measurement Chart
71— 71

PXScale.Multiplier

A
S:I:l\‘lin Time (s) Wait (ms)
Ooo Oooooooo OO0 ooo El 1222 g 7 :: --------------- @)
Case Structure Stop Butto
Property Nodes  Constants (if-else) Condition

Arrays  Note! To do something with an object — Right-click on it (When shall the loop end?)
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o LabVIEW MathScript - o Bl

LabVIEW e e E—
This is the core LabVIEW installation that installs | - |
the LabVIEW Programming Environment.
=2 LabVIEW I »:z’”y
( [2\) Create Project € [ ) Open Existing
- -LabVIEW MathScrlpt RT Module

>/, Set Up and Explore »/) Do a Project
Set up and leam how to use See examples an

LabVIEW Control De5|gn and Simulation Module

--| This module is a text-based tool that is very similar to MATLAB. The syntax
-+ is similar to MATLAB, you can create and run so-called m files, etc. The
module is available from the Tools menu inside LabVIEW.

00
d

Control & Simulation

| & search | =, Customize~ |

This module is used for creating Control and Simulation applications

with LabVIEW. Here you will find PID controllers, etc. The module is at

available as a palette on your block diagram. PID Fuzzy Logic :
(1 earchwgomize-‘ - - %

5 DAQmXx is the Hardware Driver needed in order to use hardware devices like NI

e % USB-6008, NI TC-01, etc. inside LabVIEW. The module is available as a palette on
me o f‘gl Wg your block diagram.
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LabVIEW Environment

This window appears when you start LabVIEW:

You shall not use —
this one (yet)

g

Select File -> New VI (Ctrl + N) in order to start using LabVIEW
,@3 LabVIEW - o HEN |
File fperate Tools Help

= LabVIEW ¢ 2y

/ (D = Rieiest i @ Open Existing

Recent Project Tem;Iates | All -

myRIO Project Blinking Led Example lvproj
Potentiometer demo lvproj
Discrete LED lvproj

Test myRIO Ivproj

C:\Work\Development\LabVIEW"\Blinking Led Example‘\Main.vi

C:\Work\Development\LabVIEW \myRIO\Main .vi

“k Set Up and Explore »+ Do a Project > Get Support
Set up and leam how to use NI myRIO! o See examples and get inspired! - Get answers to your questions!

ACQUITE, ATNdIyZE, dfiu VISUdIILZE UdLd VWILII LADVICVY cU 14

£ LabVIEW News | : > : —
- Tacklina Data Challenaes - Four NIWeek 2014 Sessions You Shouldn’t Miss

‘Students: S

tart LabVIEW in order to get started



front panel LADVIEW Environment

ﬂ Untitled 8 Front Panel

=1 = == Note! Both the Front Panel and

File Edit View Project Operate Tools Window Help

the Block Diagram are stored in

— L
o> | :\IE I 15pt Application Font |~ ngv H'-T]T:,v “gv | |L'%>?' ||> Search A IE

Create your User Interface/HMI here

-~

one single file. These files are
called Vls (because the file
extension is “vi”). VI = Virtual
Instruments

13 Untitled 8 Block Diagram o[ [=)

File Edit View Project Operate Tools Window Help

o [ @ \@ lL.n|lE’ 7 | 15pt Application Font |~ Hg,;.v “'-_[']Ev l I%@V ‘ I- Search

Switch between them: Ctrl + E

6Students: Try this

Block Diagram

Create your Code here




Controls and Functions Palette

' {31 Controls

You can pln" them! _> & Functions

ontrols
CkSearch‘ oo

Available only from the Front Panel
You create your User Interface with help of
these Controls

Wiew ¥ ‘

¥  Modern

Ji@) !ﬁ i q6
Nri: String & P’ath Q_
iits )
Array, Matrix Graph -
LT |g &, » c
= =
“‘"%E“.“"‘ - Students: Open the 3
O[j Ll

Refnum Yariant & Class Decorations co nt ro I S a n d F u n ct I 0 n S %

> stem
X palettes and browse the &
» Express . . | -
» Control De.sign&Simulation Conte nts N the d |ffe re nt S
> "TJET &Actlve>-< O

> Sianel Processing subpalettes >

Q
» User Controls s
Select a Control... (v}
L
O
5
>_

these Functions

Right-click on the Front Panel

e
Q Search ' Do Wi ™ ‘

Synchronization Graphics & So...

vV VvV VVVVVVVYyVVYYY

v

¥ Programming

EJ
B

v

=]
feol]
N

Structures Array
> >
Mumeric Boolean

il
©

Il
o
3
k=)
b
X
w
o
3
=|
3
5
@

£
al

File IfO wWaveform
@ > - >
—m>

Measurement IJO
Instrument IfO
vision and Motion
Mathematics

Signal Processing
Data Communication
Connecktivity
Control Design & Simulation
SignalExpress
Express

Addons

Favorites

User Libraries

Select a vI...
Statechart

e
—®
Cluster, Class...

[ee<l *

String

o

Dialog & User...

a

Application C...

Report Gener...

Right-click on the Block Diagram

Available only from the Block Diagram



Customizing Controls and Functions Palettes

i3 Change Visible Palettes

Controls (=)

Q, Search | &, Customi~~=1 You are modifying the Controls palette.
View This Palette As [

= =
II Silver - @
S SorENInnE b etre L )

2
[ Available Palette Categories k\_)
J—— — val a e
o E! — — g
— ange Visible Palettes... Modern ~
Numeric Bool — ——

Silver

Options... —_—
@@ > [— P
. = (o] System Deselect All
0 (=) > ﬁl ‘ | Classic
Array, Matrix... List, Table & ... Graph Express

Control Design & Simulation Smaaell =t

NET & ActiveX
Signal Processing
Addons

User Controls
Select a Control...

v

Teo change the category visibility of the Functions palette, invoke this
dialog box from the Functions palette.

Students: Do this for both the
Controls Palette and the Functions 0
Palette 1 OK Cancel Help
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@ run the Progam  From pana Simple Example

File Edit . i Project Operate Tools Window Help ] T ,_,?;, Controls
o> || @[ 1] [ 15pt Application Font |~ |[$o~ |[7Ga~ |[E&~ | (€5~ |[+] search 2, |[2|HIH= VS.
g Find these Controls and Indicators in the Controls B Indicators
 Numeric e and place them on the Front Panel (Right-
o2 click on the | in order to make the What is the difference?
Controls Palette visible) ws
.- Block Diagram

File Edit View Project Operate Tools Window Help

x
I¢1@| (QEI"":'I'E. + || 15pt Application Font |~ | o~ I'-_[']T:,v | I@v |I-I Search Q |

Controls Indicator

Numeric

Sh2sp
DEL!

Numeric 3

Numeric 2

Students: Create this simple
example. Try “Minus”, “Dividg

o M 9 &
and “Multiply” as well. Save them Connect these together using the “Wiring tool” (your mouse)
as 4 different Vls -

>



File Edit View Project Operate Tocols Window Help

|CD |@| l@l 11 | | 15pt Application Font |~ “_Epv ”‘-_I']—n' ||gv ||®v "..| Search

Q [?]

OTH
—|I@1>

Numeric

Numeric 2
3

Numeric 3

e

File Edit View Project Operate Tools Window Help gl
|C> |@| @IE‘ |‘-N:||’E"_;JH 15pt Application Font |~ ||Ep' "'-TJE' | |@' "%”-I Search Q | 1
~
— Numeric 3
1.23] [
= — =
Numeric 2
=
<



Celcius to Fahrenheit - Example

Front Panel
= Convert Celcius to Fahrenheit.vi Front Panel = =
File Edit View Project Operate Tools Window Help -
— C->F[
|r.{> |@| 19@ | 15pt Application Font |~ ||31:|' ||'-TJT:' “g‘ ||@' ||“)'<- | i 9
~
. . Tk = Tc + 32
o] ()

Block Diagram

Window Help

Note! The ObjeCtS may look File Edit View Project Operate Tools

different depending on your
configuration, but that doesent

matter

‘Students: Create the Front

Panel and Block Diagram in
this example.




i3 Convert Celcius to Fahrenheit.vi Front Panel - ol o

File Edit View Project Operate Tocls Window Help -|:
C->F

[=> [ ©[nn] [15pt Application Font |~ |[Zm~ |[<a~ [y~ |[¢b~ |[- X |[?] 4

~

File Edit View Project Operate Tools Window Help
|| g |23 |walm@® 7 | 15pt Application

.
LTI




How-To Fix Errors/Bugs

Items with errors

LS

1 errors and warnings Show Warnings |

® Block Diagram Errors
You have connected a Control to a Control. Change one to an inc

Double-click on the Error message and
2¢ LabVIEW will show you where the Error is!

C L o e 154 TS WITE TS TOTTWO

such sources. You must remove a source, perhaps by changing a
control to an indicator.

Close I K Show Error | l Help

e O o Error list

Items with errors

3 errors and warnings Show Warnings, | _

@ Block Diagram Errors
Add: Contains unwired or bad terminal
You have connected an Indicator to an input of Add. Change the

You have connected a Control to an output of Add. Change the c

E

® Untitled 3 Block Diagram *

5> —n ‘L.D‘TE’[ || 11pt Application Font |~ || §o~ || '!.,’—ﬁk

iNumeric Control Numeric Control 2

Examples?
Try to create the same bugs as shown here.

| coln lL.g‘lE" _fH 11pt Application Font |~ HgmvH:‘u;v| %

Deta

awis Double-click on the Error message and

cont

suenl | abVIEW will show you where the Error is!

Numeric Control

'
'
i :>—5 Numeric Control 3
0

T ‘x’ ____________
Numeric Control 2 CEL
-E

| Close H Show Error || Help 1

Click Ctrl+B in order to remove All “broken wires”




e 0 0 =) Data Types.vi Front Panel

& [&|[@] 11| [ 11pt Application Font |~ |[$o | Ha~ |[e2~ | [25~ | |H_|_H|
+

Data Types

,
\

e O O =) Data Types.vi Block Diagram

Ir:;egezrl |@E |L.0|IE" _‘rH 11lpt Application Font |~ | '!__g-ta;

Booleanl :lDOUb|"1| DOublEZl
[ Y fizs [iz3]

DEL! DEL!
Stringl String2 Integer 1

=

nteger2

Error In Error Out Boolean 1 Boolean 2|
status code status code
= @
412 @ 412
TF
source source —_,l
Error when writing to Error when writing to String2
DB DB I
Eabc
=71
) Error Oua
Array - Numericl Array - Numeric2
] - =
7 ; o=
1= 1= -
= = Array - Numeric2|
“;p.zs
H
Array - Stringl Array - String2 '[Em
Car - Car C =
— 5tringl Array — String2
Plane Plane
E=E=
Train = Train ¥ H
k
IEE\—
Enuml Enum2|
Enuml Enum2

Students: Create this Example using the different Data Types in LabVIEW



Ctrl + H | need Help!!

Where can | find it?

In the Help
menu you will
find Examples,

LabVIEW Help... I/ Ctrl+; L
Context Help x o etc.

Find Examples...

\ ~ Find Instrument Drivers...
Random Number (0-1) Web Resources...

When you use Ctrl + H, you may click on all kind of objects (both on
Front Panel and Block Diagram) on the screen to get help, e.g., how
built-in functions are working, etc. T

Lock Context Help

number (0 to 1)

o FE < < O

Hide Locate Back Forward Options

Produces a double-precision, fleatin Random Number (0-1) Function

Contents | Index ] §earch] Favorites

i Owning Palette: N ic Functi
point number betwgen Oand 1. The || 3 0 Dpross Numenc Fundiors A ng umeric Functions
number generated is greater than or [2] Absolute Value Requires: Base Development System
ual to o E Add Produces a double-precision, floating-point number between 0
L i i - .
eq but Iess than 1 . The [2] Compound Arithmetic and 1. The number generated is greater than or equal to 0, but
distribution iS uniform. E D ent less than 1. The distribution is uniform.
E Divide - Iternatively, you can use several of the Signal Generation Vis
2 ress Math & Scientific | or the Signal Generation PtBvPt VIs to regenerate the same
Detailed hel E I ent random sequence. For example, the Uniform White Noise VI
—2 E '; chine Epsil allows you to set a seed number that you can use to initialize
s achine bpsilon the generation of a pseudorandom pattern.
=[a]2] < 5 iy
2] Negate =7
% NZative Infiity number (O to 1)
. [2] Numeric Constant
St u d e nts : Try t h IS O n % sitve Iin ] Add to the block diagram Find on the palette
:
. . 2] Reciprocal . . .
d Iffe r.e nt O bJ e CtS O n yo u r 2] Round Toward -Infinity nl{rr;ber (t? tc; lt) isa céoub:ieipreclslon, floating- A
Z Round Toward +Inf|n|‘ty point number etween an -
[2] Round To Nearest v
= _ . - - -

BIOCk Diagra m < 22 E] Submit feedback on this topic. N




R —— - _ http://www.ni.com/pdf/manuals/376039a.pdf
Ed LabVIEW Quick Reference Guide

File Tool Icon Description
Ctrl-N Create new VI Ctrl-Z Undo last action Right-Click  Display controls/ Automatic [ == Automatically choose the
Ctrl-S Save VI Ctrl-Shift-Z Redo last action functions palette Tool Selection appropriate tool
Ctrl-P rint Shift-Right- Display tools palette
Operate Click
Edit Operatin Change the value of a control or select
- Ctrl-R Run VI Ctrl-T Tile block diagram and front b g IE e
Ctrl-V Paste Obje?t Ctrl-. Abort VI panel win dovgs Tool the text within a control
Ctrl-U Clean up diagram
Ctrl-Space Activate quick drop Window Help
: . Positioning - Position, resize, and
Ctrl-B Remove broken wires - !
Ctri-C c - ctrl-E Display block diagram/ Cui-H Display context help Tool select objects
- opy an object front panel
Ctrl-X Cut object
Labeling @ Edit text and create
Tool free labels
Tool lcon Description Tool Icon Description Wiring Tool mfﬁ%ﬁ;ﬁ?er
Show Context Display the context help window Run Execute the VI
Help
i i i Scrolling Tool Scroll the window without using the
Text Settings Change the font setting for the VI, List Errors | * List errors that prevent the VI from running g @ scroll bocs g
5 - | including size, style, and color
I ot Appl Lo d ] Run Execute the VI continuously until abort or N ) i
- - - - Continuously pause is pressed Breakpoint @ Set breakpoints on Vls, functions,
Align Objects g~ | Align selected objects Tool (Used for wires, loops, sequences, and cases
Abort Stop VI execution immediately debugging)
Execution
Distribute Objects |"'—- Space objects evenl
! = pa ) v Execution Animate data movement on the block Probe Tool Create probes on wires and display
Highlighting diagram wires (Used for , |ntenne(<}?te values on a wire in a
- " — - N . debugging running
Resize Objects l#‘ ] S‘?g&ugge front panel objects to Pause E] Temporarily stop execution to debug a
portion of the V|
Get Color Copy colors for pasting with the
Reorder |@- Reorder the layers of Step Into Single-step into a subVl or Tool Color Tool
the objects structure to debug it
Clean Up Rearrange wires and objects on the Step Over Execute a subVI or structure and Coloring Tool |‘ 2 Set the foreground and
Diagram E— block diagram pause at the next one background colors
Enter Appears when a new value is available Step Out Execute a subVI or structure and resume
to replace an old value single-stepping



http://www.ni.com/pdf/manuals/376039a.pdf

Front Panel ) Run the Program

Label

Q)

" Front Panel: Find these Controls in
the Controls Palette and place them

_, on the Front Panel with proper labels

ggBIock Diagram: Find the While

Loop in the Functions Palette and — -

place it on the Block Diagram
Note! To do something with an object — Right-click on it!

While Loop

Example: A voltage signal [0-5V] from a DAQ
device needs to be converted to the equivalent
level values in a water tank [0-20cm]

‘Students: Create this Example

(2) Block Diagram: Connect these together
using the “Wiring tool” (your mouse)

Block Diagram

cm

a2 -

ait (ms) Stop Button

=] While LOOp @ ...................




Waveform Chart

Plot0 |/
Thermometer

50_

o

Temperature Celsius

Time

50—
47.5-

45-
42.5-
40_
LT
Ee
Tl
30-
ZEa

25

2‘;3 22.5-'
20_

Lower Temp Limit

Upper Temp Limit

Plotting

This example simulates the
Temperature in an “Air Heater”
system. The Temperature in the Air
Heater should be between 20 and 50
degrees Celsius. We use the Random
Generator in LabVIEW in this Example

Waveform Chart
=

[@' IZO l] [@ [ 0 I] Bl stop |
ndom Number (0-1)
Students: ' U?Per Temp Limit

* Create this Example

* Try out different options on the Chart,
e.g. Autoscale, different Modes, Grid,
Layout, Colors, etc. (Right-click on the

Chart)

x =
52 o MRS
DELE

Thermometer

Lower Temp Limit

Wait m s)

I

=
DELU

Stop Button

..................

While Loop

Note! To do something with an object — Right-click on it



File Edit View Project Operate Tools Window Help

()[40 [15pt Application Font |~ |[2=~ |[<a~ |[#25~ | [~ |

Waveform Chart

50
47.5-]
45-

4.8
b8h

Temperature Celsius
g
T

Amplitude
fis

~N
u
1

h

- Example

Charts vs. Graphs

Students: Create this VI in order to see the
difference between a Chart and a Graph

Waveform Graph

Replace with Shift Register
Numeric Palette >
Array Palette >

Create

While Loop Properties
Right-click on the border
Rndom Number (0-1)
x

Upper Temp Limit

[so}
Lower Temp Limit

Tunnel Mode | = =b At AlUE o

< Indexing

= Eonenternting = =

Conditional

Waveform Graph

5
o

+

Waveform Chart

[20]

Soel




Charts vs. Graphs

Chart:

* Remembers history — New point added to end of the
plot

* Used inside a While Loop/For Loop
* One new point is added each time
Graph:

* You plot all the data at once — typically an array with
data

* Used outside a While Loop/For Loop
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|

i3 Convert Celcius to Fahrenheit.vi Front Panel =

File Edit View Project Operate Tools Window Slelect |npUtS and OU
||:> I@l @IE] I 15pt Application Font |~ ”gmv ”'-'ﬁ;v |g _I E9~ ' S u V I S
Acput

T Icon that makes it easier

Bl () to understand what the
SubVl is doing
Create a nice icon as well

(Control) (Indicator)

<

A SubVI is the same as a File Edit View Project Operate Tools Window Help
function or a method used

in other languages

this SubVI




. Use the Icon Editor in order to create
lcon Editor

a descriptive icon for your SubVI.

O Icon Editor (Convert Celcius to Fahrenheit.vi)

. Templatesrl lcon Text ] Glyphsr[i Layersr‘

Line 1 text |c->F . Line 1 color N
Line 2 text . Line 2 color
Line 3 text . Line 3 color
Line 4 text . Line 4 color
Font .
Center text vertically
Small Fonts 4

. itali
Alignment Capitalize text

center i :! 10 2

OK Cancel Help




i3 Temperature.vi Front Panel

- ]
File Edit View Project Operate Tools Window Help &
I@ I@I |@|EI I 15pt Application Font |~ ||3;,v “'-_uhnv ”g' ”@V ”-I Search ;L IE
~

i Using SubVIs

Temperature [Fahrenheit]

Tocls Window Help
< ™~ 1|5 7 | 15pt Application Font |~ || 8o~ ||Toa~ | |2 <A, I@j

While Locop

Temperature [Celsius]| Convert Celcius to Fahrenheit.vi| emperature [Fahrenheit]|
Students: Create this VI
Stop Button

o
SubVI ¢reated in previous slide

(just drag it on the Block Diagram with your mouse




S u bVl S Here you see some of the

advantages with using SubViIs.

[ -NsNs) =] World Temperature.vi Front Panel ‘
(&[] @1 || 110t Appication Fore |- |3~ e~ | |5~ |  [RIETH <] =
Temperature in Celsius Temperature in Fahrenheit |c:> |@| ‘@| 1 | l ‘g I IQE'J |L'U!'E" JH 11pt Application Fs ic’
Oslo Oslo
Stockholm Stockholm Oslo Oslo
=18 64.4
Berlin Berlin 23 c>rg 23]
ra 19 £ DEL! DEL
L;ndon Stockholm Stockholm
London
El2s 77 S FE] =>rg fzs]
Tokyo Tokyo DEL DEL
=Zlzs | Berlin Berlin
Paris Paris =)
- Hzz C-:F fizz]
m 20 ,SB—I DEL H DEL
London London
23 c>ry 23]
DE L] DEL
Tokyo Tokyo
Hzz C->Fﬂ fzz]
DEL GEL
S d C h E | Paris Paris
tudents: Create this Example po— - ==
GEL DEL




Front Panel Multiple Plotting and SubVIs

File Edit View Project Operate Tools Window Help
> [ [@u] Students:
Waveform Chart "l Create this program
130 Celsius W
120- / Fahrenheit [~

us
:

"o-\/\ \}\/\j /\N Block Diagram
80- /\/ \(’ﬁ \/\/ File Edit View Project Operate Tools Window Help %I

o> I@l @'E] II.N:.IIE’ -+ | 15pt Application Font |~ ”gpv "'-'ﬁ?,v I I - I 2

Temperature Celsi
3
|

60— ~
m_
— — - -~
20 Temperature Simulator.vi - S\ Waveform Chart
30- em [
20- Sim. |
0 b P
Time Convert Celcius to Fahrenheit.vi
- c->ra
Wait (ms) Stop Button
Random Number (0-1) Temperature (Celsius
@ . plizs ( ) 1000 @’ AAAAAAAAAAAAAAAAAA
m -
Lower Temp Limit Su bVI
>
Do you see how simple and intuitive the
code becomes when using SubVIs? SubVi
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Writing Formulas

Hans-Petter Halvorsen



LabVIEW Formula Node

Context Help

Formula Node

int32 y;

if(x>=0)
y=1;

else vy =-1;

input varisble
(optional)

output variable
[optional)

Evaluates mathematical formulas and expressions similar te C on the block diagram. The

following built-in functions are allowed in formulas: abs, acos, acosh, asin, asinh, atan, atan2,
atanh, ceil, cos, cosh, cot, csc, exp, expm1, floor, getexp, getman, int, intrz, In, Inp1, log, log2,
max, min, mod, pow, rand, rem, sec, sign, sin, sinc, sinh, sizeOfDim, sqrt, tan, tanh. There are
some differences between the parser in the Mathematics VIs and the Fermula Node.

Formula Node: Create and use C code

within LabVIEW

Example:

Detailed help

ril
EV\

=&[2] <

Very useful for mathematical
expressions and simulations!

~ float b;
float p;
b=1;

p= D.S,'
xk=xk1+Ts*(b*xk1-p*xk1*xk1);




LabVIEW Formula Node

Celsius to Fahrenheit:

T = =T¢c + 32 Students: Use the LabVIEW Formula Node in
5 order to implement this formula

Advanced Mathematical Formula:
Given a=1,b=3,c=5
Find f(9)

Try also with other values for a, b, c

In(ax? + bx + ¢) — sin (ax? + bx + ¢)
4x? + cos (x — 2)(ax? + bx + ¢)

flx) =

ﬂ Students: Use the LabVIEW Formula Node in order to implement this formula

Try also to implement this function with ordinary
LabVIEW blocks. What is easiest to implement? (The answer should be f(9) = 0.0044)



£3 Formula Node Example.vi Block Diagram

Window Help £ In(ax? + bx + ¢) — sin (ax? + bx + ¢)
15pt Application Font |~ || 3o~ || 0o~ - x ==
SIS Y 4mx? + cos (x — 2)(ax? + bx + ¢)

File Edite, View gProject @perate Tools

= f = (In(@*x*x + b*x +¢) - sin(@*x*x + b*x +c)) /(4*pi*x*x + cos(x-2)*(a*x*x + b*x +c)); f
hzzp -
B !
b
ﬁ b] £ Formula Node Example.vi Front Panel - O X
cf.m n Notel File Edit View Project Operate Tools Window He[TT 3
\c-éL | ) p— = '\:',"K
x o [ Iﬁf__;l@ | 15pt Application Font |« |@ mlln 1
s | A
E3 Formula Node Example2.vi Block Diagram Alte rn ative SOl utio n . - a X | :
File Edit View Project Operate Tools Window Help g} 1
la@} “mm[@! {Yal@® I I‘VISptApplication Font |v Hgn‘ ]lﬁ'”@v}gl- Search 4 }@ —

~ b f

: float g; t =3 0,00437378
123 bﬁ}? ;—J

o= Fg = a*x*x + b*x +¢;

=i of = (In(g) - sin(g)) /(4*pi*x*x + cos(x-2)*(g)); S/

- Which Solution do you think is best?




LabVIEW MathScript Node

Context Help

MathScript Node

input variable 1 SumA = eyve(size(A));

(optional) 2 fori=1in
input vatiable 2@ SumA = Sumd + A”~ifFactonal(i); output vatiable
(optional) 4 end (optional)
5 Delta = SuméA - expmx(A);
SO in oo ccc 2HYOF OUt

Executes LabVIEW MathScripts and your other text-based scripts using the MathScript RT Medule engine. You can use the
MathScript Node to evaluate scripts that you create in the LabVIEW MathScript Window.

If a MathScript Node contains a warning glyph, LabVIEW operates with slower run-time performance for the node. You
can modify your script to remove the warning glyph from the MathScript Node and improve run-time performance.

Detailed hel

(=812 « >

Very useful for
mathematical
expressions and
simulations!

MathScript Node: You can create and use MathScript/MATLAB code within LabVIEW



LabVIEW MathScript Node
Celcius to Fa(;renheit: ﬂ

T = =T + 32 Students: Use the LabVIEW MathScript Node in
5 order to implement this formula

Advanced Mathematical Formula:

In(ax? + bx + ¢) —sin (ax?2 +bx+c¢) Cvena=Lb=3c=5

47152 + coS (x — 2)(ax2 + bx + C) Find f(9)
Try also with other values for a, b, c

flx) =

ﬂ Students: Use the LabVIEW MathScript Node in

order to implement this formula (The answer should be f(9) = 0.0044)



. _In(ax? + bx + ¢) — sin (ax? + bx + ¢)
SO|Ut|0nS fe) = 4mx? + cos (x — 2)(ax? + bx + ¢)

£} MathScript Node Example.vi Block Diagram - O X
File Edit View Project Operate Tools Window Help 3
> | (;j@ Wa|@® 7 | 15pt Application Font |~ || 3o ||*0a~ | [£D~ i:ﬁ' A ]
~
: 1 g=a"2+b*x+c
e 2> f = (log(g) - sin(g)) /(4*pi*xA2 + cos(x-2)*(g))
f £} Formula Node Example.vi Front Panel - m] X

File Edit View Project Operate Tools Window Hef @}
|§>l@| I\‘;IEI I 15pt Application Font H-J\ I@

|

f

nﬂu |

ﬂj]

=

ﬂ:|3
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More Loops & Structures
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Loops & Structures

MATEEEE % [For Loopl
F | N

= =

Stop Button)|

m ' |

Case Structure, Flat Sequence Structure
W Truen True DoooOO0O0O00O0000O0000000000000000000000

False

Sequence Structure

Case Structure

.
If eISe nnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnn
e see



Specify Number of Iterations

[For Loop|

[[oHN

Shift Register -—> =

Right-click on the
border and select “Add
Shift Register”

Numeric Indicator|

I1.23:

I3z

Arra
T iz=]

Current Iteration

‘Students: Create this Example

Tunnel Mode

Array Palette

Properties

Replace with Shift Reqgister
Numeric Palette

e |

Right-click on
the border

4

~ Constant
Control

T




T4 False ~p

Case Structure

Case Structure

&

m‘*j True

False
Numeric Controll

iz

Numeric Indicator]

DEL

Numeric Control 2| B

g [ “Boat” hd =i
TF +
IThis is a Boat}"'mz?_i_
—

Case Structure

The Case structure is the same as
if... else... used in other
programming languages like C#,
etc.

Write either “Car” or “Boat”

and see what happens
‘Students: Create these Examples

IThis is aCar["" z




IFIatSeguenceStructure| I
100000000000 0 0 0 0 00000 0000000000000 octC

IThis is aTrainl"“L‘_E;T___

IThis is a Carl""L'_E-:'_
1

Ucture

Flat Sequence Structure

Stacked Sequence Structure

DE.."‘IG[U..].]TP!DDDDDDDDDDDDDD

O0O00000000000000o00o0o0o0o0oo0o0oecr

One__Button Dialog|
2 The “One Button Dialog” can be

2

| I—

 I—
used to give a popup message to
the user
QStudents: Create these Examples ;
OO0 0000000000000 000000000000000000a00



For Loop)
N

For Loop

v

Flat Sequence Structure|

DooO0oD0D00D0D00000000000000000000000000

Sequence Structure

DooDooDooooo0o0o000000

Doooooooooooooon

File Edit View Project Operate Tools

Window Help

Numeric Control

=

Case Structure

M Truens True

False

Numeric Indicato

Numeric Control 2|
!

[ 1231
’ == o

Boolean|

R

Case Structure

When

and Structures, you can
create Advanced and
Powerful Applications

Combining Loops

While Loop

Stop Button|

|'\ Search

Stacked Sequence Structure]

[While Loop

[>]=] (;)@ [wa|@ .+ [ 15pt Application Font |~ [~ |[ia~ | [2D~ [+

2 WI

0000000000000 00000

Chart Initialization

Measurement Chart
21 —— )%

PXScale.Multiplier

[o}-23

o I B I e e e B B i s R s s B = R R

your own Pl controller

|Note! Replace this controller with |

Case Structure

% "Real Process” 't]

51—

Control Chart| i

PID Centroller.vi
:‘ et
PID

[TReat

PID Parameters|

BLY—

v
ﬁ

=

Sampling Time (s)

Process 3
i _ga point»

ms)

TobL
o B

You will practice this soon...
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File Operate Tools Help

Bl LabVIEW 01>

Edit View Project Operate

Tools Window Help

‘ Create Project

S| X O X||sfk | EB-&all=

‘ Open. Existing

Show [ All

Items | Files I

labview_analog_voltage_io_example 3

labview_analog_voltage_io_labu@® vi
Simple DAQ Analog Outg
Simple DAQ Ang

Blank Project 7cmpo/s
Creates a blank projecy

emplates
Creates a blank VI.

Simple State Machine 7emplates

Q%; Facilitates defining the execution sequence for sections of code. More Information

Queued Handler

4> Facilitates multiple sections of code running in parallel and sending data between them. More

Information

Actor Framework Templates

Creates an application that consists of multiple, independent tasks that communicate with each
other. This template makes extensive use of LabVIEW classes. More Information

Finite Measurement Szmple Frojects
Acquires a finite measurement and provides options for exporting the measurement to disk. This
sample project is based on the Simple State Machine template. More Information
Continuous Measurement and Logging Szmple Projects
Acquires measurements continuously and logs them to disk. This sample project is based on the
Queued Message Handler template. More Information
Feedback Evaporative Cooler Ssmple Frojects

w2u[f] 'mPplements an evaporative cooler with hot-swappable hardware, controllers, and user interfaces.
This sample project is based on the Actor Framework template. More Information

Continuous Measurement and Logging (NI-DAQmMX) Szample Frojects
Implements a continuous data acquistion application using NI-DAQmx. More Information

Finite Meacurement (NLNAOMY)  S=mnle Srmimrtc

=+ [Bd Project: Untitled Project 2
=- ¥ My Computer

&
N~
28

oJ
-}
oJ
-}
]

Basic LabVIEW

Air Heater

Bacteria Population
Mass-spring-damper Simulation
PID Centrol and Simulation
resources

Students: Put all the Code you
created today into the Project
Explorer. Create Folders, etc.,

i.e. create a good Structure

It is recommended to use this when
you create larger applications that
contains lots of ViIs and other files, etc.




Customizing LabVIEW IDE

Select Tools = Options...

i3 Options = =
Category | ~ Front Panel
New and Changed
~
Block Diagram General
Controls/Functi Palett:
E entro SfFanciions Palettes [] Connector pane terminals default to Required
nvironment

Search Use localized decimal point™
Paths =
Printing Use numbers in icons of new Vlis (1 through 9)
Source Control [] Open the control editor with double-click
Menu Shortcuts - =
Revision History Blink delay for front panel controls (milliseconds)
Security 1000 =l
Shared Variable Engi
Vi ;:-vera"a e Engine *Changes to marked options will take effect the next time you start LabVIEW.
Web Server
MathScript Tip Strips and Labeling

Show tip strips on front panel controls

[]Labels locked by default

Default label position: controls

Classic v

Default label position: indicators

Classic v

Control Style for New Vis
o ) Modern style v

OK Cancel Help

Students: Change the different options according to how you want to use LabVIEW






Spaghetti Code — Bad Example 1 (“}

Eile Tools Window Help
La|E] o5 [ 13pt Application Font ~[E=-1[F=][=5-1==]
> stop (T) g stop (T) 3
F timeout () P timeout (s)
error out ) er ut M
ame code — why o
not use SubVI?
0
[R 2 auto contral
tu[False 't
valve 2
e 02z_max2

+ b -

] e o - — te

] o> IV F :

02 _minz Manualifuto 2
= i VB [Chosse controlmethod 02 measurment
[==x
Fv2
g [Manual control oz
measurmer

—{#BBL]
3 T : valve 1 e
,i OZAMEX\]@ . " =2
= i Digital Bool -
ozmnt Merualidute__ | [Chooss controlmethod ] s ] o
" ey rem-

[Manual control

m
iy
=
=

‘Structure your code! Use SubVils, Avoid Spaghetti Code, Document your Codé, etc.



Spaghetti Code — Bad Example 2

Make sure your code fits into your screen size — scrolling to see code is not good!

Manual
hsp Output range u=At"hsp/Kp+Fout_est/Kp;
DBL & 205 t4¢
:1> = ) PID :1>
S—
PID gains
L
Sétpoint range
=08
60| ?
Simulation Time, 'mUIat'on
- SRS T
1 ) PDBL i ll
Analog DBL
1Chan 1Samp
[DBL M Tank
—m | =
2 B N t))
dlm ] b e R 5 &
log DBL = L= + | _
:::?Samp e Fout[cm3/sec] TE » ¥ o} Vavefor :
m a [ At[cm2] h init[em] Noise stndard devijation : (L
=1 [oBLe- —_ | EE ] ;

=
=
o

-]

qhir
)

m
iy
=

Structure your code! Use SubViIs, Avoid Spaghetti Code, Document your Code, etc.



e
and dats acquire

i
B )
D s v

=]

v
; Duta
“inner loop er 1
-l s

. = -
o =
B [ [remeor | EaE—

[Cincar move][tatur]

| o Set airflow pressure regulator
sample mode © Mach Set Point: 3911 — " zero volts, lowest possible fic
[fio. TC Chan e lnde T [ Machindes]
[Exitt-in 7] ' -
a Pressure Xder. L= = = —
Set Voage  [HETH
*

‘@nm TC ISampile Clock ~|

[T
= s S
n TC Setup [nf:_a_@
(1o}
A [rEphyica a--nm«m—l 1 Acquire pressure, temperature dats. Perfcern mach feedback i
IRTDChanneis b L)
TVES-Rake-fiow-tunnel-| Tpro) Computer

Structure your code! Use SubViIs, Avoid Spaghetti Code, Document your Code, etc.



Bad vs. Good Code

|
| The Flow should go from left to right
' freut]
S Fimeric2 | S —
s ﬁ Soloct s rumeric 2]
'3» SoBL]
nput2 m
E T B

Avoid Spaghetti Code! Make your code readable for others!

While Loop While Loop

Temeerature [Celsius]l Convert Celcius to Fahrenheit.vil [Temperature [Fahrenheit]]

Temperature [Celsius] 2 Convert Celcius to Fahrenheit.vi] Temperature [Fahrenheit] 2|
= C->Ff 3
DEL —HI DE sl

erature [Celsius]

emperature [Fahrenheit]]

:ib{>—

EEIP

|
|
|
|
-rature [Fahrenheit] 2| I
vvvvvvvvvvvvvvvvvvvvvvv : / Use SubVis!!!
I Use Labels and Comment your Code

Temperature [Celsius] 2

Stop Button

This is a* comment @

El 5
)
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LabVIEVW Quick Reference Guide

File Tool Icon Description
Ctrl-N Create new VI Ctrl-Z Undo last action Right-Click Display controls/ Automatic [ ==] Automatically choose the
ctrl-S Save VI Ctrl-Shift-Z Redo last action functions palette Tool Selection appropriate tool
Ctrl-P rint Shift-Right- Display tools palette
Operate Click g piay P
Edit ~ X ) Operating Change the value of a control or select
Ctrl-v Paste object g::_R mr\t"w Ctrl-T ‘T)gﬁetr%':]gg‘ig;am and front Tool @ the text within a control
Ctrl-U Clean up diagram
Ctrl-Space Activate quick drop Window Help
H X Positioning - Position, resize, and
Ctrl-B Remove broken wires - H
b Conv am obiect Ctrl-E Display block diagram/ Ctrl-H Display context help Tool | I | coloct objects
Py d front panel
Ctrl-X Cut object
Labeling @ Edit text and create
Tool free labels
Tool Icon Description Tool Icon Description Wiring Tool mi?tﬁgiﬁatggaﬁ‘er
Show Context Display the context help window Run Execute the VI
Help
i i i Scrolling Tool Scroll the window without using the
Text Settings Fh?nge e fonstt: Iettingdfor Ithe Vi List Errors | > List errors that prevent the VI from running g Serol the g
= -1 including size, style, and color
I EptAppl L ] Run Execute the VI continuously until abort or _ i _
- - " - Continuously pause is pressed Breakpoint @ Set breakpoints on Vls, functions,
Align Objects |g£,- Align selected objects Tool (Used for wires, loops, sequences, and cases
Abort Stop VI execution immediately debugging)
Execution
Distribute Objects |""- Space objects evenl . .
' ! — pa jects eveny Execution Animate data movement on the block Probe Tool Create probes on wires and display
Highlighting diagram wires (Used for |nter_me<3;i'-1te values on a wire in a
Resize Objects [#8%< ] Resize multiple front panel objects to . - debugging) running
the same size Pause IEI Temporarily stop execution to debug a
portion of the VI ‘ )
Get Color Copy colors for pasting with the
Reorder |@- Reorder the layers of Step Into El Single-step into a subVI or Tool Color Tool
the objects structure to debug it
Clean Up ' Rearrange wires and objects on the Step Over - Execute a subVI or structure and Coloring Tool I‘ » Set the foreground and
Diagram H block diagram pause at the next one background colors
Enter ars when a new value is available Step Out Execute a subVI or structure and resume
to replace an old value EI single-stepping
Wt/ /awnanar R caom /nAfF/ mantiale /27602049 KA F
HILLPY ./ / VWVVVV.ITT.CUITT/ DUl /TTHIdlTuUdilS/ o0 /70VoJd. YUl



http://www.ni.com/pdf/manuals/376039a.pdf

Short-Cuts that you must know!

Short-Cut Description
Ctrl+ B Deletes all broken wires in a VI
Ctrl +. Stops the Running VI
Ctrl + E Toggle between the Front Panel and Block Diagram

Tab

Ctrl + Mouse
_wheel

Ctrl + H

Ctrl + Mouse

Double-click on a

SubVI

Ctrl + Arrows ]
_(—)(—(—sb )

Ctrl + W
Double-click on a]

wire

Cycles through the most common Tools (Automatic Tool Selection should be
disabled!)
Scrolls through subdiagrams in Case, Event or Sequence structures

Displays the Context Help window
Opens the Block Diagram directly
Move faster. You first have to select a SubVI, a Function, Object, etc

Close the SubVI
Selects the hole wire

[Ctrl + drag objects with your mouse: Copy objects (easier than Ctrl + C and Ctrl + V)]
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m Note! This is just an example to illustrate the assignment. You can create
your own User Interface with your own features.

The code should include a While Loop, Case structures, SubViIs, etc. You can

use the built-in Random Generator when playing Lottery.

Create a Lottery App in LabVIEW

Below we see a sketch:
i3 Lottery - o IEE

z Creating this App makes you practice
f%?i?é on basic LabVIEW Programming

#1 #2 #3 #4 #5 #6 #7

E4 NORSK TIPPING

A A | [> Play Lotto] N
SIS | EEN | EEE EEN S S S 2 N\
: == Add : I‘:(“ "‘( A 1012 v T N\ 2‘;5— - .“-‘ ‘. v‘l - .
Lottery Ticket: W\, /= ) )
; . 0
#1 #2 #3 #4 #5 #6 #7 N\ 4 a2 WS
33 4 8 9 8 11 20 \ '2'1_ , 34 /
Lottery Results T
#1 #2 #3 #4 #5 #6 #7
33 1) |« f |[= 1f [[= 1) |[32 1 [[n 1 [[20 1]

Your Score:

7 Correct: |0 6 Correct: |0 5 Correct: | |2

20PN MW




ChlEN Simon Says

e O O Simon Says

e

B Stop

Creating this App makes
you practice on basic
LabVIEW Programming




ChlEN LabVIEW Calculator

e O O =] Calculator [Calculator.vi] Front Panel

’:{> \{g}} [:.;:]‘ T } ’ 11pt Application Font |~ HF',H:,-

=,

Tip: Use an “Event Structure”

inside a While Loop | 0.841471)
® 0O 0O =) Calculator [Calculator.vi] Block Diagram
|_|§[ (;\L\ilj‘gu‘la’ +|[ 11pt Application Font |~ HED_'“TU_L \il_l EE— "
— - ' e XA2 e pi C /
[ (2] “Sin0": Value Change [ o S—— —
sqrt() £ 8 9 =
log() 4 5 6 -
@sse) M cos() | 1 2 3 —+
sin() | o : -




ChlEN e Level Tank E]

Assignment: Control the Level (close to the setpoint) in the Tank manually by adjusting the outflow of the tank with a
manual Valve. Plot Level and Flow.

Flow into the Tank:
_ /N /\ Pump

Fin(tk) — KpSIH (wtk) \/

w = 21tf K,

Level formula:
T.
h(ty,y1) = hgtk) + ZS | Finn (£1) — Foue(tx)]

Previc;us Level
Implement the Equations using standard LabVIEW operators like:

(= = B> [=>
Add Subtract Multiply Divide u [O%, 100%]

etc. Flow out of the Tank:
Using SubVIs are recommended! Fout(tk) — Kvu(tk)

Valve

Fout




K=NsXs)

=] Water Tank — Manual Control.vi Front Panel

h(k) = h(k-1) + (Ts/A)*(Fin — Fout)
Fin = Kp*v(t)

V [mAa3]

f[Hz)]

[2> [&||@) || 11pt Application Font |~ |[§5~ ||~ || e~ | (25~ |

Kp [mA3/s]

Level h[m]

y®

0.400145

v(t) = sin(w*t)

Fin [mA3/s]

0.040014

w = 2*pi*f

V=A%*h

Set Point [m]

A = pi * raA2
r [m]

Blos |

A [ma2]

0.785398

Manual Control, u [%]

o2
952
0.0
.ss—i
0.2
,75—?
0.7=

652

o.sé
55—
0.52
PrE
0.4
.35—2
035
5=
o.z—i
s
0.1—2
052

o=

Initial Level [m]

Zl[o.s

Kv[mA3/s]

y

| u
¥ Fout[mA3/s] 2

0.067820

Fout = Kv*u(t)

Ts [s]

FlowIn [ma3/s] [~~~ | 004 |

Flow Chart Flow Out [mA3/s] [~ ’W‘
ol If the flow out is equal
5 ox- to the flow in, you are
B able keep the setpoint

o _nms'eo[s] ‘60 7o 'so g0 100
water Level [m] [~ |[0.55 |
Level Chart SetPointiml [~ |[g50

o~

l

OK — but can you do it better?

T R Ee—— pop———————
50 60 70 80 [0 100
Time [s]

M_Stop

'
o 2.5 5 TS5

o Manually adjust the valve on the outflow

' ' ' ' ' ' ' ' ' ' | ' ' ' 1 ' 1
10 125 15 175 20 225 25 275 30 325 35 375 40 425 45 475 50 525 55 575 60 625 65 675 70 725 75 775 80 825 85 875 90 925 95 97.5 100




Hans-Petter Halvorsen

University of South-Eastern Norway

WWW.uUusn.no

E-mail: hans.p.halvorsen@usn.no
Web: https://www.halvorsen.blog



http://www.usn.no/
mailto:hans.p.halvorsen@usn.no
https://www.halvorsen.blog/

